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Hello NCKCN internet members
Netiquette Alert
Sending Holiday Cards Via E-mail
Ask The Help Desk
What Are USB And FireWire?
Sites Of The Month
Great Sites To Check Out In
November!

It's that time of the year to begin thinking about sending holiday greetings, cards,
and photos to family and friends. If you intend to send your holiday cheer via e-mail
this year, this month's eNewsletter provides tips and tutorials on making your
project more successful.
The goal of each of our monthly eNewsletters is to keep our subscribers informed
regarding their Internet connection and to improve their Internet experience. To
meet this goal, each monthly newsletter will usually contain information related to:

1. Warnings on a recent virus, e-mail hoax, or security issue that may affect
Short Tutorial
How To Use "BCC:" When Sending
Holiday Cards

2.
3.
4.
5.

you
An update on new services and other local interests
An answer to a frequently asked Internet related question
Some fun, seasonal websites to check out
A short, step-by-step tutorial on an e-mail or browser related task

We think you'll find the information contained in this newsletter to be a valuable
tool for enhancing your Internet experience. If, however, you'd prefer not to receive
these bulletins on a monthly basis, click HERE.
To see what's inside this issue, take a look at the index to the left and thanks for
reading!
- The NCKCN Team

Netiquette Alert - Sending Holiday Cards Via E-mail
Like everything else, it seems, greeting cards are going digital. Sending holiday greetings and family holiday photos by e-mail has
become commonplace. The intention, of course, is to send tidings of great joy rather than great frustration. So it's important that
everyone understand and use good netiquette when sending holiday cards and photos. Here are some guidelines:

1. You wouldn't freely share friends' phone numbers with others, so don't publish their e-mail addresses for all to see. When
sending a greeting to many people who might not know each other, use the blind carbon copy (bcc:) feature of your e-mail
program rather than the carbon copy (cc:) function. By doing this, no e-mail addresses will be inadvertently revealed.

2. Make sure card and photo files are small, i.e. one megabyte or less. If your plan is to send several attachments, each
containing many large holiday photos, consider sending a series of e-mail messages instead with only one or two photos
attached to each message. This will avoid delivery problems. Another option is to post photos online and provide a link to
the photos within your holiday messsage. Recipients could then click on the link which will take them to the web page
containing your photos.

3. Many people create cards and convert them to a digital format to be e-mailed. Make sure you save the artwork to a file type
that is common, such as PDF (Portable Document Format). Using uncommon software that most people don't have only
leads to frustration when the recipient attempts to open the file.
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Back to Top

Ask The Help Desk - What Are USB And FireWire?

Question: I've heard friends mention that they have USB and FireWire connections on their computers. What do these terms mean
and how do I know if I have these connections on my computer?
Answer: USB (an acronym for Universal Serial Bus) and FireWire are two types of a "bus" — a collection of external cords that
transmit data from one part of a computer system to another. FireWire is also known as iLink on some devices and computers.
In modern computers, USB 1.1 establishes the hardware-to-computer connection for peripherals, such as mice, keyboards, printers,
and joysticks, that don't require fast data transmission rates. USB supports data transfer rates of up to twelve megabits per second
(Mbps).
In 2001, the USB standard underwent an extensive overhaul resulting in the new USB 2.0 standard. It has much faster (480Mbps)
transfer rates and can be effectual when connecting digital cameras and video cams to computers. The same USB cable will work
for both USB 1.1 and USB 2.0 devices as there is no difference in the shapes of USB 1.1 or USB 2.0 ports.
There are two types of FireWire devices, FireWire 400 and FireWire 800. The older standard is FireWire 400, also referred to as the
IEEE 1394 bus. It transfers data at 400Mbps. The newer FireWire 800 standard transfers data at a blistering 800Mbps, a speed
required to transfer high-quality video and images. This type of bus is used to connect such hardware as CD and DVD burners,
digital cameras, video editors, camcorders, and high-end scanners.
Nearly all computers built since 1999 have either USB 1.1 or USB 2.0. Look at your computer's ports. If you see a rectangular port
with a stick figure by it, you have a USB port. FireWire ports are hexagonal and have a symbol that resembles the letter "Y" next to
them.
Back to Top

Great Sites To Check Out This Month

See Pictures Of People Doing The Phoon
http://Phoons.com - Have you "phooned" for anyone lately? Well, you may have and not even known it. Ask someone to take a
picture of you while you're in a phoon pose (arms and legs bent in a running position, turned sideways, not looking at the camera or
smiling) and send it into this site for posting. Hundreds of people have already done so. Check out the images of people doing the
phoon in crowds, in foreign countries, on fountains, at theme parks, in tight fits, at airports, on beaches, in costumes, with animals,
and more.
Lost Is Big Hit In Second Season
http://abc.go.com/primetime/lost/index.html - The popular, multiple Emmy-Award winning television program, Lost, is back for
another mystery and action-packed season. The show's official site provides links to bios on each cast member. It also includes a
"Lost Trivia Challenge" game that'll test your Lost expert skills. Videos clips as well as recaps from previous episodes will keep you
up-to-speed in case you missed a show. Plus, lots of photos from both seasons are available for viewing.
Countdown To Macy's Thanksgiving Day Parade
http://www1.macys.com/campaign/parade/parade.jsp - Almost every year since 1924, the Macy's Thanksgiving Day Parade has
helped kick off the holiday shopping season. (No parade was held during 1942-1944 as Macy's donated the rubber used to make
balloons toward the war effort.) Over 2.5 million people will line the streets of Manhattan on Thanksgiving morning to enjoy the
huge balloons as well as the spectacular floats, skillful marching bands, and popular celebrities -- and, of course, to see Santa Claus!
Visit this site to learn more about the parade's history and to go behind the scenes to see how 4,000 volunteers pull off this amazing
event.
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Top Secret Aerial Photographs From WWII
http://www.evidenceincamera.co.uk - This recently upgraded site, created by the Aerial Reconnaissance Archives (TARA) at
Keele University in England, will eventually provide access to over 5.5 million aerial photographs taken over occupied Western
Europe during WWII. Aerial photographs taken by the Germans during WWII and until recently was classified NATO property,
will also be available for viewing on this site. Aerial images include the Allied invasion of Normandy, the Bismarck hiding in
Norway, and the Auschwitz concentration camp. If you can't access the site on your first attempt, try again later. The site is getting
many hits and is worth the visit.
Zoom Into Exact Map Location
http://www.us.map24.com - Here's an alternative to using MapQuest.com for driving directions or looking for map-related
information. This site, of course, gives you helpful driving directions. However, the most unique feature is the point and draw
option for finding address locations in cities and towns across North America. Simply draw a box (using your cursor arrow) on your
monitor screen around the area that you want to closely review. The page automatically zooms into the exact location you are
looking for. It's pretty amazing technology!
Back to Top

Short Tutorial - How To Use "BCC:" When Sending Holiday Cards
Getting cards and photos from friends via e-mail attachments can be great fun. What's not so great is when people send a card to
you but then "cc:" (carbon copy) one hundred of their other friends on the same message. You see everyone else's e-mail address
and they see yours. This may not be so bad unless the e-mail gets forwarded to a spammer who then adds your e-mail address to his
spamming list and/or sells it to other spammers.
The correct method of sending a holiday greeting card via e-mail to your friends and family is to use the "bcc:" (blind carbon copy)
feature. It's found on all commonly used e-mail software programs. This function hides the e-mail addresses of all recipients of your
greeting — which will give them more to be jolly about!
Sending BCC: Messages in Outlook Express When Using Windows XP

1. Open Outlook Express and click on the "NEW" button located at the top of the program's toolbar.
2. If the "Bcc:" (Blind Carbon Copy) header is not visible, go to the View menu and select "ALL HEADERS." The "Bcc:"
header and field should appear under the "Cc:" header and above the "Subject" header.

3. Click your cursor arrow on the "Bcc:" button and the Select Recipients window will appear.
4. Select one of the contacts or one of the groups by clicking on its name and then click on the "Bcc:" button. Do this for as
many contacts or groups as you want to receive the e-mail. Then click "OK" to go back to your message.

5. You will notice that the names of the groups or recipients are now in the "Bcc:" field.
6. Enter a subject, compose your message, and click the "Send" button on the toolbar. That's all there is to it. Since you used
the "Bcc:" header, no one receiving your message will be able to see anyone else's e-mail address.
Sending BCC: Messages in Thunderbird 1.07 When Using Mac OS X or Windows XP

1. Click your cursor arrow on the "Write" button.
2. If the "Contacts" pane is not visible on the left hand side of the new e-mail, click on the "Contacts" button and it will appear.
3. Select the contacts in the list by either double clicking on the individual contacts or by control clicking on them and then
using the "Add to To:" button.

4. However, you don't want those addresses in the "To:" field; you want them in the "Bcc:" field. You'll notice a small
downward pointing arrow button on the left side of the "To:" field. If you click on it, you'll see other header options
including the "Bcc:" option. Click on "Bcc:" to select it from the drop-down menu. Do this for all of the contacts you want
in the "Bcc:" field.
5. Now, compose your e-mail, give it a subject, and hit the "Send" button.
Sending BCC: Messages in Netscape 7.2 When Using Windows XP or Mac OS X
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1.
2.
3.
4.

Open Netscape 7.2 and go to the "Window" menu. Drop down to "Mail & Newsgroups" to go to the e-mail client.
Click your cursor arrow on the "Compose" button to create a new e-mail message.
Click on the "Address" button. The "Select Addresses" dialog box will appear.
Click on the addresses to which you want to send the e-mail in the address book pane on the left hand side of the window
and click on the "Bcc:" button. The addresses that you selected will move over to the "Address message to:" pane.
5. Click "OK."
6. Now compose your e-mail message, give it a subject, and hit the "Send" button.
Sending BCC: Messages in Mail.app When Using Mac OS X

1. Click your cursor arrow on the "New" button to create a new e-mail message.
2. To see the "Bcc:" field, go to the "View" menu at the top of your screen and drop down to "Bcc Header." The "Bcc:" field
3.
4.
5.
6.

will now appear highlighted with a flashing cursor.
Click on the "Address" button and the "Addresses" window will appear.
Double click on the contact entries to add them to the "Bcc:" field.
Close the Address book window.
Compose the rest of your e-mail message, give it a subject, and then hit "send."

NOTE: You don't have to put anything in the "To:" field of the e-mail using these programs. However, if you don't, some spam
filters may block the e-mail or send it into the recipient's spam folder. To solve this dilemma, put your own e-mail address into the
"To:" field. It's already in the message's header as the sender so it's no secret anyway and you'll get a copy of the message that
you're sending.
Back to Top

We hope you found this newsletter to be informative. It's our way of keeping you posted on the happenings at our shop. If,
however, you'd prefer not to receive these bulletins on a monthly basis, click HERE.
Thanks for your business!
Thank You,
The Staff at NCKCN
NCKCN.COM

NCKCN - North Central Kansas Community Network
109 North Mill
Beloit, KS 67420
785-738-2218
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(We have used our best efforts in collecting and preparing the information published herein. However, we do not assume,
and hereby disclaim, any and all liability for any loss or damage caused by errors or omissions, whether such errors or
omissions resulted from negligence, accident, or other causes.)
©2005 Cornerstone Publishing Group Inc.
Trademarks: All brand names and product names used in this eNewsletter are trade names, service marks, trademarks or registered
trademarks of their respective owners.
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